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LESSON SKILL MATRIX

Skill Exam Objective Objective Number

Adding SmartArt to a Slide Create SmartArt graphics.

Convert lists to SmartArt graphics.

3.3.1

3.3.2

Modifying SmartArt Apply styles to shapes and text boxes.

Change the color of SmartArt graphics.

Add shapes to SmartArt graphics.

Reorder shapes in SmartArt graphics.

2.2.5

3.3.5

3.3.3

3.3.4

SOFTWARE ORIENTATION

Choosing a SmartArt Graphic

PowerPoint offers eight different types of SmartArt with many layouts for each type. Figure 
7-1 shows the dialog box that appears when you choose to insert a SmartArt graphic.

SmartArt types SmartArt layouts Explanation of how the selected layout can be used

Figure 7-1

Choose a SmartArt  
Graphic dialog box

When you click a layout, the right pane of the dialog box shows you a close-up view of the selected 
layout and provides information on how to use the layout. !is description can help you decide 
whether the layout will be appropriate for your information.
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ADDING SMARTART TO A SLIDE

Use the Insert a SmartArt Graphic icon in any content placeholder to start a new SmartArt 
graphic. After you have selected a type and a layout, you can add text to the SmartArt graph-
ic. PowerPoint also lets you use existing bullet items to create SmartArt.

Inserting a SmartArt Graphic

SmartArt graphics (also called SmartArt diagrams, or just SmartArt) are visual representa-
tions of information you want to communicate. SmartArt shows items of related information in a 
graphical way that makes their relationships easy to understand. You can use SmartArt to present 
text information in a more visually interesting way than the usual bulleted or numbered formats. 
An organization chart is a type of SmartArt that shows the relationships among personnel or 
departments in an organization. Organization charts are included in the Hierarchy layouts. In this 
exercise, you will insert an organization chart.

STEP BY STEP Create SmartArt 

GET READY. Before you begin these steps, make sure that your computer is on. Sign on, if 

necessary.

1. START PowerPoint, if the program is not already running.

2. OPEN the Litware presentation from the data files for this lesson and then SAVE it as 
Litware Final.

3. Go to slide 3 and click the Insert a SmartArt Graphic icon in the center of the content 

placeholder. The Choose a SmartArt Graphic dialog box opens.

4. Click Hierarchy in the type list in the left side of the dialog box. The layouts for the 

Hierarchy type are displayed.

5. Click the first layout in the first row, the Organization Chart. Read the description of the 

Organization Chart layout in the right pane of the dialog box.

6. Click OK to insert the chart. The chart appears on the slide (see Figure 7-2).

7. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Figure 7-2

A new, blank organization 
chart
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Adding Text to SmartArt 

A new SmartArt graphic appears on the slide with empty shapes to which you add text (and in some 
cases, pictures) to create the final version. !e appearance and position of these shapes are guided by 
the layout you chose; shape color is controlled by the current theme. As you enter text, PowerPoint 
resizes the shapes to accommodate the longest line of text. Font size is also adjusted for the best fit 
and PowerPoint keeps the font size the same for all shapes. In this exercise, you will learn how to add 
text to the organizational chart that you created in the previous exercise.

An organization chart, such as the one you create in this section, has some special terminology and 
layout requirements. In an organization chart, there can be only one top-level shape, which 
is typically occupied by the name of the person or department at the head of the organization. 
Persons or departments who report to the top-level entity are subordinates. An assistant is a 
person who reports directly to a staff member and usually appears on a separate level.

STEP BY STEP Add Text to SmartArt 

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Click Text Pane on the SmartArt Tools Design tab. This action opens the Text pane. You 

can also click the arrow on the far left of the Organization Chart’s border to open the 

text pane.

2. At the top of the Text pane, type Ted Hicks to enter the name in the top-level shape. 

Notice that as you type the text in the Text pane, it appears in the top shape (see Figure 

7-3) and the text automatically resizes to fit in the shape. 

Text Pane button 
on Ribbon

You can type text here, 
or in the shape itself

Text Pane button 
on SmartArt Top-level shape

Assistant shape Subordinate shape

3. Click in the bullet item below Ted Hicks in the Text pane, then type Rose Lang. Rose 

Lang is an assistant to Ted Hicks, and as such, she has an assistant shape on a level 

between the top-level shape and the subordinate shapes.

Figure 7-3

Type a name in the top-level 
shape
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4. Click in the next bullet item in the Text pane and type Marcus Short. Marcus Short is a 

subordinate to Ted Hicks.

Take Note Do not press Enter after typing the names because that inserts a new shape. If you accidentally do 
so, click the Undo button on the Quick Access Toolbar to undo the addition.

5. Click in the next bullet item and type Ellen Camp.

6. Click in the last bullet item and type Pat Cramer.

7. Click the Close button (X) in the Text pane to hide it. You will complete the text entry by 

typing directly in the shapes.

8. Click just to the right of the name Hicks in the top-level shape, press Enter and type 

Director. Notice that the text size adjusts in all the shapes to account for the additional 

entry in the top-level shape.

9. Click after the name Lang in the assistant shape, press Enter, and then type Assistant 

Director.

10. Use the same process to type the title Reading Products for Marcus Short, Linguistics 

Products for Ellen Camp, and Writing Products for Pat Cramer.

11. Click away from the SmartArt to deselect it. Your slide should look similar to Figure 7-4.

12. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note If you need to edit text you have entered in a shape, you can click the text to activate it and then 
edit the text as necessary. You can also right-click a shape, click Edit Text on the shortcut menu, 
and then make the necessary changes.

Converting Text or WordArt to SmartArt

As you work with slide text, you may realize that the information would work well as a Smar-
tArt graphic. In this situation, you do not have to retype the text in the SmartArt shapes. 
Simply convert the bulleted list to a SmartArt graphic. You can create SmartArt from any 
bulleted list on a slide or any WordArt object. You can choose one of the common layouts 
in the Convert to SmartArt gallery, or you can access the Choose a SmartArt Graphic dialog 
box to choose any type or layout. In this exercise, you will learn how to convert a list into a 
SmartArt Cycle graphic and you will convert WordArt text into a single SmartArt object.

Figure 7-4

The completed organization 
chart
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STEP BY STEP Convert Text or WordArt to a SmartArt Graphic

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 4 and select the bulleted list.

2. Click the Home tab, if necessary, and then click the Convert to SmartArt button in the 

Paragraph group. PowerPoint displays the gallery (see Figure 7-5).

3. Click More SmartArt Graphics at the bottom of the gallery. The Choose a SmartArt 

Graphic dialog box opens.

4. Click Cycle and then click the Block Cycle layout (third layout in the first row). Read the 

description of how best to use the Block Cycle layout.

5. Click OK. The bulleted list is converted to a cycle graphic (see Figure 7-6).

Take Note You may notice that the text in the shapes is quite small. 

Figure 7-5

The Convert to SmartArt 
gallery

Figure 7-6

Bulleted list converted to a 
cycle graphic
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6. Go to slide 1 and triple-click the Developer Orientation WordArt object to select it. 

7. On the Home tab, click Convert to SmartArt, then click Vertical Bullet List (the first 

layout in the first row). The WordArt text is converted to a single-item SmartArt object.

8. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

MODIFYING SMARTART

Although a SmartArt graphic makes an interesting visual statement on a slide in its default 
state, you will probably want to make some changes to the graphic to customize it for your 
use. You can apply a wide variety of formatting changes to modify appearance and you 
can also change layout or orientation and add or remove shapes. You can even change the 
SmartArt type to another that better fits your data.

Applying a Style to SmartArt 

Like other graphic objects, SmartArt can be quickly and easily formatted by applying a Smar-
tArt style. Styles apply fills, borders, and effects to improve the appearance of the graphic’s 
shapes. In this exercise, you will apply a style.

STEP BY STEP Apply a Style to SmartArt 

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 3 and click once on the SmartArt graphic to select it. Take care to select the 

SmartArt itself; don’t select a particular shape within it.

2. Click the SmartArt Tools Design tab to activate it.

3. Click the More button in the SmartArt Styles group. The SmartArt Styles gallery 

appears (see Figure 7-7).

4. Click the Inset style. (It is the second style in the first row of the 3-D section.) 

PowerPoint applies the style.

Figure 7-7

The SmartArt Styles gallery
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5. Go to slide 1, click the SmartArt object, and then repeat steps 2-4 to apply the same 

style. 

6. Go to slide 4, click the SmartArt object, and then repeat steps 2-4 to apply the same 

style.

7. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Selecting a Color Theme for SmartArt 

By default, SmartArt uses variants of a single theme color. Use the Change Colors gallery 
to apply a different theme color. In this exercise, you will apply a different color theme to a 
SmartArt graphic.

STEP BY STEP Apply a Color Theme to a SmartArt Graphic

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 3 and click the SmartArt graphic to select it. Click the SmartArt Tools 

Design tab if it is not already displayed.

2. Click the Change Colors button in the SmartArt Styles group. The Change Colors 

gallery opens.

3. Click the fourth style in the Colorful section (Colorful Range – Accent Colors 4 to 5). 

PowerPoint applies theme colors differentiated by level.

Take Note Differentiating levels or processes by color gives your audience further visual cues that help them 
understand the SmartArt graphic.

4. Go to slide 4 and click the SmartArt graphic to select it.

5. Click the Change Colors button in the SmartArt Styles group, opening the Change 

Colors gallery, and then click the first style in the Colorful section (Colorful-Accent 

Colors). PowerPoint uses theme colors to apply different tints to each shape.

6. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Changing a SmartArt Graphic’s Layout

If you decide a particular layout does not present your data as you like, you can easily choose a new 
layout. A different layout can dramatically change the way the data appears. Different layouts may 
be more or less suited to your data, so you may want to try several different layouts to find the best 
match. In this exercise, you will change a SmartArt graphic to a different layout.

STEP BY STEP Change a SmartArt Layout 

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Click the SmartArt graphic on slide 4 to select it, if necessary. Make sure you select the 

outer frame of the graphic—not an individual shape.

2. Click the More button in the Layouts group to display the Layouts gallery.

Take Note !e Layouts gallery displays alternative layouts for the current type.

3. Click Continuous Cycle (see Figure 7-8). PowerPoint applies the new cycle layout to the 

current chart.
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4. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note It is also possible to convert one type of SmartArt to another. 

Adding a New Shape to a SmartArt Graphic

As you work with SmartArt, you may need to add shapes to accommodate your information. 
Use the Add Shape button to choose what kind of shape to add and where to insert it in the 
graphic. Adding a new shape to a graphic causes all the existing shapes to resize or reposi-
tion to make room for the new shape.

STEP BY STEP Add a Shape to a SmartArt Graphic

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 3 and click the SmartArt graphic to select it. Make sure you select the 

graphic’s outer frame; don’t select a specific shape within it.

2. Click the SmartArt Tools Design tab.

3. Click the last shape in the last row (Pat Cramer) to select it.

4. Click the Add Shape drop-down arrow in the Design tab, Create Graphic group. 

PowerPoint displays a menu of options for adding a shape relative to the current shape. 

(You can also right click the shape and click Add Shape.)

5. Click Add Shape Below. PowerPoint adds a subordinate shape to the Pat Cramer shape.

Take Note Notice that the new shape, which is on a new level, has a different theme color to differentiate it 
from the level above.

6. Type Hannah Wong in the new shape, press Enter, and then type Product Coordinator. 

Then click away from the graphic to deselect it. The slide should look similar to Figure 

7-9.

Figure 7-8

The Layouts gallery for the 
Cycle type
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Newly added shape

7. Select Hannah Wong’s shape. On the SmartArt Tools Design tab, click the Add Shape 

drop-down arrow and then click Add Shape Below. PowerPoint adds a subordinate 

shape.

8. Type Allan Morgan into the new shape, press Enter, and then type Software Design.

9. With Allan Morgan’s shape still selected, click the Add Shape drop-down arrow and 

then click Add Shape After. PowerPoint adds a shape on the same level.

Take Note In step 9, had you clicked the face of the Add Shape button rather than its arrow, PowerPoint 
would have added a new shape subordinate to the selected one.

10. Type Kyle Porter in the new shape, press Enter, and then type Package Design.

11. Click away from the graphic to deselect it. Your slide should look similar to Figure 7-10.

Figure 7-9

A new shape has been added

Figure 7-10

New subordinate shapes have 
been added
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12. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note You cannot add a shape above the top-level shape in an organization chart.

Removing a Shape from a SmartArt Graphic

You can easily delete shapes you do not need. When you remove a shape, PowerPoint re-
sizes the other shapes to take advantage of the increased space in the SmartArt container. 
Font sizes usually increase accordingly, too. For this reason, you should not do any manual 
formatting of text and shape size until you have finalized the number of shapes.

STEP BY STEP Remove a Shape from a SmartArt Graphic 

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 4 and click the SmartArt graphic to select it.

2. Click the Update shape to select it. Make sure you select the shape and not the text 

within it.

3. Press Delete. PowerPoint removes the shape and reconfigures the SmartArt graphic.

4. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Reversing Direction

You can change the look of a SmartArt graphic by modifying the way shapes are positioned. 
You can use the Right to Left and Layout buttons to adjust the orientation. In this exercise, 
you will reverse a graphic’s direction and change the layout of a section of an organization 
chart.

STEP BY STEP Reverse Direction

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 3 and click the SmartArt graphic to select it. Make sure you select the entire 

graphic.

2. Click the SmartArt Tools Design tab if it is not already displayed.

3. Click the Right to Left button in the Create Graphic group. PowerPoint flips the graphic 

horizontally so that shapes on the right side are now on the left side.

4. Click in the top-level shape (Ted Hicks). Make sure you select the shape; don’t select the 

text within it.

5. Click the Layout button in the Create Graphic group. PowerPoint displays options for 

positioning the shapes relative to the top-level shape.

6. Click Left Hanging. The subordinate shapes are arranged vertically below the top-level 

shape, rather than horizontally (see Figure 7-11).
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7. Click the Layout button and then click Standard to restore the previous layout.

8. Click the Hannah Wong shape, click the Layout button, and then click Both. The 

subordinate shapes display horizontally rather than vertically.

9. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Reordering Shapes 

In addition to changing the SmartArt graphic’s entire orientation, you can also reorder the 
individual shapes by using the Move Up and Move Down buttons. Be aware, however, that 
the directions “up” and “down” are relative and, depending on the position of the shape, 
may not correspond to the actual direction being moved. In this exercise, you will move a 
shape to a different location in a SmartArt graphic.

STEP BY STEP Move a SmartArt Shape 

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 4 and click the SmartArt graphic to select it.

2. Click the Testing shape.

3. On the SmartArt Tools Design tab, click Move Down. The shape moves one position in 

a clockwise direction. Note that in this example, Move Down actually moves the shape 

upward in the graphic.

4. Click Move Up. The shape moves one position in a counter-clockwise direction.

5. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Figure 7-11

The subordinate shapes 
appear vertically
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Promoting and Demoting Shapes

You can add, remove, or modify shapes by promoting or demoting text. When you promote an 
item, you move it up a level. When you demote an item, you make it subordinate to the item 
above it in the hierarchy. !is procedure is similar to changing the indent level of items in a bul-
leted list. In the following exercise, you will learn how to promote a shape.

STEP BY STEP Promote a Shape

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Click the SmartArt graphic on slide 3 to select it if necessary.

2. Click the Text Pane button on the SmartArt Tools Design tab.

3. In the Text pane, click the Hannah Wong bulleted item. Notice in the Text pane that this 

item is indented below the Pat Cramer bulleted item.

4. Click the Promote button in the Create Graphic group. Hannah Wong’s shape jumps up 

one level and her two subordinates are also promoted.

5. Click the Text Pane button to hide the Text pane again.

6. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Choosing a Different SmartArt Type 

Sometimes the hardest part about working with SmartArt is selecting the type and layout that will 
best display your data. Fortunately, you can easily change the type even after you have created and 
formatted a SmartArt graphic. Some types of SmartArt will convert very well to a different type, 
while others will not fit the shape layout of the new type at all. You may need to retype information 
to display it properly in a different type. !e following exercise shows how to select a different type 
and layout. 

STEP BY STEP Choose a Different SmartArt Type and Layout

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 4 and click the SmartArt graphic to select it.

2. Click the More button in the Layouts group on the Design tab and then click More 

Layouts at the bottom of the gallery to open the Choose a SmartArt Graphic dialog 

box.

3. Click the Process type in the left pane, then scroll down and click the Upward Arrow 

layout in the center pane (third row from the bottom).

4. Click OK. PowerPoint converts the SmartArt graphic to the Upward Arrow type.

5. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.
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Changing Shape Appearance

Final adjustments to a SmartArt graphic include tweaking the size of shapes and modifying text 
formatting. PowerPoint formats shapes so that all will fit comfortably in the placeholder. If you 
have only a few shapes, you might find that these adjustments result in a graphic where shapes are 
much larger than they need to be to hold their text. Conversely, you may want to increase shape 
size to draw attention to one specific shape. !ese types of appearance changes can improve the 
look of a graphic and make it easier to read. In this exercise, you will learn how to change the size 
of a shape.

STEP BY STEP Change Shape Size

 GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Select the SmartArt graphic on slide 4 if it is not already selected and then click the 

Needs/Market Analysis circle (the circle nearest the thin end of the arrow graphic) to 

select it. Make sure you select the circle, not the text.

2. Click the SmartArt Tools, Format tab.

3. Click the Larger button in the Shapes group twice to increase the size of the smallest 

circle.

4. Click the Design/Proof of Concept circle shape and then click the Larger button once to 

increase the shape’s size.

5. Click the Roll-out circle shape and then click the Smaller button in the Shapes group 

once to decrease the shape size. Then click away from the graphic to deselect it.

Take Note If you select the text box rather than the shape, click outside the text box to deselect it and then 
try again by clicking the left edge of the shape with the four-headed pointer.

6. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Take Note You can also change shape appearance by selecting a completely new shape: right-click a shape, 
click Change Shape, and then select the desired shape from the Shapes gallery.

Changing Text Formatting

PowerPoint automatically adjusts font sizes to fit in or around shapes. If you do not find the 
size or color of text in a SmartArt graphic attractive or easy to read, you can use the Home 
tab formatting options to adjust font formats such as size, color, or style. You can also adjust 
alignment in shapes just as you would in any PowerPoint placeholder.

If you modify text formats with the SmartArt graphic selected, all text within the graphic will 
display the new format. To apply a new text format to a single shape, select that shape first. Text 
placeholders are selected the same way as other slide placeholders are. In this exercise, you will 
format the text in a SmartArt graphic.
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STEP BY STEP Change Text Formatting

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. On slide 4, select the outer frame of the SmartArt graphic (not a specific shape within 

it).

2. On the Home tab, click the Font Size drop-down arrow and then click 20. PowerPoint 

changes the size of all text in the graphic to 20 point.

3. Click the Needs/Market analysis text box and drag its border to reduce its width 

slightly so that the word Market moves completely to the second line.

4. Click the Design/Proof of concept text box and expand its width so that the word Proof 

displays completely on the first line.

5. With the Design/Proof of concept text box selected, press the right arrow key on the 

keyboard three times to move the text box slightly to the right so its text does not 

overlap the circle shape.

6. Widen the Development text box so the word fits on a single line and then move the 

text box to the right slightly, as you did in step 5. Then click away from the graphic to 

deselect it.

7. Move the Testing text box to the right slightly. The completed slide is shown in Figure 

7-12.

8. Go to slide 3 and click the SmartArt graphic to select it.

9. Click the outside edge of the Ted Hicks shape. 

10. Click the Font Color drop-down arrow on the Home tab and then click Black, Text 1. 

The text in that shape is now easier to read against the light green fill.

11. Click the Bold button on the Home tab. All text in the shape is bolded. Then click away 

from the graphic to deselect it.

12. SAVE the presentation.

PAUSE. LEAVE the presentation open to use in the next exercise.

Figure 7-12

The completed process chart
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Converting SmartArt

When you convert SmartArt to text, the text in the SmartArt object changes to a bulleted 
list. Top-level shape text becomes top-level bullet points and subordinate shapes become 
subordinate bullets. When you convert SmartArt to shapes, the diagram changes to a set of 
drawn shapes and lines, like the ones you might draw yourself using the Shapes button on 
the Insert tab. In this exercise, you will convert SmartArt diagrams to text and graphics.

STEP BY STEP Convert SmartArt 

GET READY. USE the Litware Final presentation that is still open from the previous 

exercise.

1. Go to slide 4 and select the SmartArt object.

2. On the SmartArt Tools Design tab, click the Convert button and then click Convert to 

Text from the menu that appears. The SmartArt is converted to a bulleted list.

3. Go to slide 3 and select the SmartArt object.

4. On the SmartArt Tools Design tab, click the Convert button and then click Convert to 

Shapes. The diagram changes to a set of shapes.

5. Click inside the diagram to confirm that the SmartArt tabs on the Ribbon do not appear.

6. Click one of the diagram’s shapes. Notice that the Drawing Tools Format tab becomes 

available, indicating it is a drawn shape object.

SAVE the presentation and then CLOSE the file. EXIT PowerPoint.

Knowledge Assessment

Matching

Match the term in Column 1 to its description in Column 2.

Column 1 Column 2

1. Promote  a.  Holds the name of the person or department at the head of the 

organization

2. SmartArt b. Panel in which you can type SmartArt graphic text

3. Top-level shape c. Increases the level of the item in the hierarchy

4. Text pane d. Visual representation of information

5. Subordinate e. Someone who reports to the head of the organization

True/False

Circle T if the statement is true or F if the statement is false.

T F 1. Text in a SmartArt graphic can appear either in a shape or in a bulleted list.

T F 2. The Standard Colors gallery allows you to apply variations of theme colors to a 

SmartArt graphic.

T F 3. The Add Shape Below option inserts a subordinate shape.

T F 4. To remove a shape, select it and press the Delete key on the keyboard.

T F 5. You have to retype text if you change from one SmartArt layout to another.
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Projects

Project 7-1: Using SmartArt to Show Company Reorganization 

In this project, you are the director of operations at Fabrikam, Inc., a company that develops fabric 
treatments for use in the textile industry. Your company is undergoing reorganization and you 
need to prepare a presentation that shows how groups will be aligned in the new structure. You 
can use a SmartArt graphic to show the new organization.

GET READY. LAUNCH PowerPoint if it is not already running.

1. OPEN the Reorganization presentation from the data files for this lesson and then 

SAVE it as Reorganization Final.

2. Go to slide 2 and click the Insert a SmartArt Graphic icon in the content placeholder.

3. Click the Hierarchy type, click the Hierarchy layout, and then click OK.

4. Click in the top-level shape and type Operations.

5. Click in the first second-level shape and type Production.

6. Click in the second second-level shape and type R & D.

7. Click in the first third-level shape and type Manufacturing.

8. Delete the other third-level shape under Production.

9. Click in the remaining third-level shape (under R & D) and type Quality Assurance.

10. Click the Manufacturing shape to select it. Then click the Add Shape drop-down arrow 

and select Add Shape Below.

11. Type Fulfillment in the new shape. Then click away from the new shape.

12. Display the SmartArt Styles gallery and click the Polished style (which might be the 

first style under 3-D, depending upon your screen size).

13. Display the Change Colors gallery and click one of the Colorful gallery choices.

14. Display the Layouts gallery and click the Horizontal Hierarchy layout.

15. SAVE the presentation and CLOSE the file.

PAUSE. LEAVE PowerPoint open for use in the next project.

Project 7-2: Using SmartArt to Improve Presentation

In this project, you work for the city manager of Center City. She has asked you to create an agen-
da to display at an upcoming meeting of the city’s department heads. She has supplied the bulleted 
text on an existing slide. You can use this text to make the agenda look more interesting.

GET READY. LAUNCH PowerPoint if it is not already running.

1. OPEN the Meeting Agenda presentation from the data files for this lesson and then 

SAVE it as Meeting Agenda Final.

2. Click in the content placeholder, click the Convert to SmartArt button, and then click 

More SmartArt Graphics.

3. In the List category, click the Vertical Box List layout and then click OK.

4. Click the first shape to select it, click the Add Shape drop-down arrow, and then click 

Add Shape After.

5. Type Budget Cuts in the new shape.

6. Display the Layouts gallery and click the Vertical Bullet List layout.

7. Display the Change Colors gallery and under the Accent 5 heading, click the 

Transparent Gradient Range – Accent 5 option.

8. SAVE and CLOSE the file.

EXIT PowerPoint.


